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Mission Overview
In this tutorial, we will model a Mission to Pluto. Starting from the Earth, we will: 

1. Use the Target Vector Outgoing Asymptote parameters to specify our outgoing state.  

2. Target a Jupiter Swingby using B-plane parameters 

3. Target a Flyby Mission of Pluto. 

 

At the end of this exercise we will have: 

1. Used a SPICE file to add a central body to Astrogator. 

2. Used Multiple Profiles to achieve our desired Flyby parameters at Jupiter. 

3. Created Pluto-Centered views in STK. 

4. Created a trajectory that leaves the Earth enters heliocentric space, performs a flyby at Jupiter 
and encounters Pluto. 
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Setting Up the Scenario 

Setting up to Scenario and Animation Times 

Before we start this scenario, we want to setup our SPICE files for use within STK.  SPICE 
(Spacecraft, Planet, Instrument, C-matrix--spacecraft attitude--, and Events) files are created with 
the SPICE toolkit, maintained by the Jet Propulsion Laboratory (JPL) and are used to define the 
position and velocity of various bodies in space.  In the New Horizons Tutorial Folder, you will 
find two Spice Files:  Jupiter.bsp, and Pluto.bsp.  These files contain ephemeris information on 
the Moons of Jupiter and Pluto. 

1. Copy Jupiter.bsp and Pluto.bsp to the install/STKData/Spice directory.  We will use these 
later when we define our central bodies in Astrogator. 

2. Open a new scenario in STK. By default, you should get a 3D Window and a 2D Map. We will 
configure these windows later for our mission.  

3. Name the scenario ‘New_Horizons’. 

4. Specify the timeframe of the mission. This is important since the objects that don’t fall within 
the interval of the scenario will not be displayed. The orbit epoch of this particular mission is 
Jan 19th, 2006. This is a good reference time for our scenario; therefore, we will use it as our 
start time. 

a. Right click on the ‘New_Horizons’ scenario and select Basic Properties. On the 
Time Period page, enter the follow parameters: 

Time Period 

Element Value 

Start Time 19 Jan 2006 12:00:00.00 

Stop Time 25 Jan 2006 12:00:00.00 

Epoch 19 Jan 2006 12:00:00.00 

 

b. Select the Animation page and introduce the following dates: 
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Animation 

Element Value 

Start Time 1 Jan 2007 00:00:00.00 

Time Step 60 sec 

 

 

 

Note 
You can access the Basic Properties of any object in STK by double-clicking on its object icon.

 

Setting up the 2D and 3D Windows 

We are now ready to configure the 2D and 3D windows for our mission to Pluto.  We will use the 
following settings to visualize the orbit from both Jupiter and Pluto perspectives. 

2-D WINDOW SETTINGS 

5. Select the 2-D window, and click on the Central Body button    from the 2-D Graphics 
toolbar. 

6. Change the Central Body to Jupiter. 

7. Select the 2-D window, and click on the Properties button  from the default toolbar.  

8. From the Details Page, Turn off Image and deselect all the high resolution detail Items. 

9. From the Projection page: 

a. Change the Type to Orthographic. 

b. Change the Display Coordinate System Frame to ‘CBI’ (Central Body Intertial). 

c. Change the Display Height to 1e+007  km. 

d. Change the Center to Lat = 90 deg & Lon = 39.5 degrees. 

e. Turn on Show Axes and click on the Format… button.  
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i. Turn on All Axes. 

ii. Change the color to Green for Plus and Red for Minus.  

iii. Change the scale to 1000 for all Axes.  

iv. Change the coordinate frame to CBI  

f. Click on Apply when done and on the reset button to refresh the 2D Map. 

10. Dock the 2-D window to the top of your application (Select the window, and right click on the 
upper blue bar of the window for these options).  We’d like the windows to be visible during 
targeting so it’s best not to leave them Integrated, or Floating.   

11. Create a second 2D window by selecting Duplicate 2D graphics Window and duplicate the 
Jupiter Centered window. 

12. Change the Central Body to Pluto. 

13. From the Projection page: 

a. Change the Type to Orthographic. 

b. Change the Display Coordinate System Frame to ‘CBI’ (Central Body Intertial). 

c. Change the Display Height to 30,000  km. 

d. Change the Center to Lat = 90 deg & Lon = 9.5 degrees. 

e. Turn on Show Axes and click on the Format… button.  

i. Turn on All Axes. 

ii. Change the color to Green for Plus and Red for Minus.  

iii. Change the scale to 1000 for all Axes.  

iv. Change the coordinate frame to CBI  

f. Click on Apply when done and on the reset button to refresh the 2D Map. 

g. Dock the 2-D window to the top of your application next to the other window. 

3D WINDOW SETTINGS 
14. Select the 3-D window, and click on the Properties button. 

a. From the  Globe page, change the Central Body to Sun. 
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b. On the Advanced Page, change the Visible Distance to 1e+012 km 

c. On the Grids page, turn the Ecliptic grid on, change the color to dark gray, and show 
radial lines. 

d. Back out away from the sun, and dock the 3D window to the top. 

15. From the View menu, Create a new 3D Graphics Window. 

a. From the  Globe page, change the Central Body to the Pluto. 

b. From the Grids page, turn on the CBI grid. 

c. On the Advanced Page, change the Visible Distance to 1e+012 km 

16. Dock this 3D window to the top as well, and try to position things to that you can see them. 
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Populating the Scenario 

In this particular scenario, we only need two types of STK objects: Planets and Satellites.   While 
we actually will be creating some moons, in STK these are classified as Planets as well. 

CREATING THE PLANETS 
17. With the scenario selected, from the Insert menu, select New and then Planet.  

a. From the Basic Properties of the new planet, on the Definition page, select ‘Pluto’ 
as the central body. 

b. Select the Ephemeris Source to be ‘Analytical’.  We will use this setting to show the 
full orbit of Pluto.  While the JPL DE405 ephemeris file will be used for Pluto’s 
position, the DE405 doesn’t contain a full orbit of Pluto.  STK has an internal analytical 
approximation of Pluto’s orbit that we can use visually to show the orbit. 

c. From the 2-D Graphics/Attributes page, deselect Inherit from Scenario, Show 
Subsatellite Point, and Show Subsatellite Label and select the Show Orbit box, 
and select the color.  Hit apply and then OK. 

18. Copy and Paste Pluto into the scenario, and redefine it to be Mars.  Change the color (on the 
2D graphics Attributes page) and change the name. 

19. Do the same and create Jupiter, Saturn, Uranus, and Neptune. 

20. Copy and Paste Pluto into the scenario again, and then redefine it to be ‘Earth’. 

a. Configure the planet the same as Pluto, except select the color to be blue and change 
the name to ‘Earth’.  For Earth you can allow the Ephemeris Source to be ‘Default’. 

CREATING THE MOONS 
There are two parts to bringing in new central bodies.  First we must create them in the 
Astrogator Browser, and then we must bring them in as planets in the normal way. 

21. From the ‘View’ menu, select the Astrogator Browser. 

22. Within the Browser, select the ‘Central Bodies’ folder. 

23. Find the ‘Deimos’ central body, and duplicate it. 

24. Make the following changes to the copy of Deimos: 
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a. Rename it ‘IO’ 

b. Change the Parent planet to Jupiter. 

c. Change the Gravitational Parameter to 5.9594E+03 km^3/sec^2. 

d. Change the Min Radius and Max Radius to 1821.6 km 

e. Change the Ephemeris to JPL Spice, and the Spice ID to 501 

 

f. Duplicate Io and use the following settings for the other Moons: 

Moon Grav. Param. Radius Spice ID
IO 5.9594E+03 1821.6 501
Europa 3.2026E+03 1560.8 502
Ganymede 9.8872E+03 2631.2 503
Callisto 7.1784E+03 2410.3 504
Charon 1.0809E+02 593.0 901  
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If STK detects Spice files during startup, it will make these files available in STK.  Thus, any reference 
we make to these files from the Astrogator Browser will only work if we’ve installed the Spice files in 
the appropriate directories before-hand.  JPL uses a particular numbering convention for Planets,  
Moons, Asteroids and Comets.  Before you can set up the CB definition in the Astrogator Browser, 
you will need to know what the Spice ID for the bodies are. 

 

Note 

 

25. Create the new ‘Planets’ in the Object Browser as you did on step 17.  Copy the planet ‘Earth’ 
and then create new planets (and colors) named: IO, Europa, Ganymede and Callisto.  Reset 
your 3D window and all the objects should now be visible. 

 

CREATING THE SPACECRAFT 
26. With the scenario selected, from the Insert menu, select New and then Satellite.  Dismiss the 

orbit wizard. 

27. Name the satellite ‘New_Horizons’.  
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28. Select the Basic Properties of the satellite. 

29. From the Orbit page, change the propagator to ASTROGATOR.  

30. Remove all the segments in the Mission Control Sequence (MCS) using the Delete Segment 

button . 

31. On the 2-D graphics page/Pass page turn the Orbit Track/Lead Type to All and set the 
Ground Track/Lead Type to None. 

32. On the 3-D graphics page/Pass page turn the Orbit Track/Lead Type to All. 

33. From the 3-D graphics/Model page: 

a. Change the Marker to ‘Point’  

b. Change the scale to 7.  

c. For the Detail Thresholds, slide the Marker label and the Marker bars to the maximum.  

 

The following Mission Control Sequence requires input from an external program to seed the initial 
conditions for a Jupiter swingby that goes to Pluto.  In this case we have used data generated by 
Trajectory Optimizer (Trajopt) by SAIC.    A simplified student version of this software is available 
for $50.00 US that allows up to 4 nodes.  The program is old and runs under DOS, but it still works! 

 

Note 

Building the Mission Control Sequence (MCS) 

Get out of Orbit. 

1. Create a new Target segment, and label it ‘Target_Pluto’. 

2. Inside the target segment, add an initial state segment. 

a. Set the Element type to Target Vector Outgoing Asymptote. 

b. Set the  Orbital Elements as follows: 

i. Orbit epoch = 19 Jan 2006 00:00:00.00 UTCG 

ii. Radius of Periapsis = 6778 km. 
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iii. C3 Energy = 158.0 km^2/Sec^2. 

iv. RA of Outgoing Asymptote = 210.0  deg. 

v. Declination of Outgoing Aysmptote = -9.0 deg. 

vi. Velocity Azimuth at Periapsis = 0 deg. 

vii. True Anomaly = 0 deg. 

c. Set C3, RA and Declination as Controls.  

3. After the initial state segment, add a propagate segment named ‘Prop to SOI’.  Change the 
color as you see fit. 

a. Leave the stopping condition as ‘Duration’. 

b. Change the Trip value to 2 Days. 

c. Set the Propagator to ‘Cislunar’. 

4. Add a propagate segment named ‘Prop to Jupiter’.  Change the color as you see fit. 

a. Change the stopping condition to ‘Periapsis’, and make it relative to Jupiter. 

b. Add another stopping condition of ‘Altitude’, change this to be WRT Jupiter, and set 
the ‘trip’ value to be 100,000 km. 

c. Set the Propagator to ‘Heliocentric’. 

d. Click the ‘Advanced’ button, and change the Maximum Propagation Time to 
1000 days. 

5. After the ‘Prop to Jupiter’ segment, add a propagate segment named ‘Prop to Pluto’.  Change 
the color as you see fit. 

a. Change the Propagator to Heliocentric. 

b. Give the segment a stopping condition of periapsis (WRT Pluto).   

c. Click the ‘Advanced’ button, and change the Maximum Propagation Time to 20 
yr. 

Fly By Jupiter 

6. Turn on Draw Trajectory as it is Calculated under the MCS Options button on the 
Astrogator Toolbar. 
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Target the B-Plane 

Our initial state from Trajopt will take us close to Jupiter, but when we get there we will want 
to make sure we have the proper encounter geometry to cause us to execute a gravity swingby 
of Jupiter that takes us to Pluto.  The best way to do that is target the B-plane. Trajopt will 
give us the B-plane parameters we need at Jupiter to continue on the Pluto.  If we match these 
parameters, we should then be close enough to an encounter with Pluto that Astrogator can 
target us the rest of the way in. 

The B-plane is a planar coordinate system that allows targeting during a gravity assist or for 
planetary orbit insertion. It can be thought of as a target attached to the assisting body.  If you 
have a trajectory that is close to the encounter planet, the B-plane gives you targets that 
behave very linearly as you target for them, which is important with the differential corrector 
targeting scheme in Astrogator.  However, had we targeted the B-plane before we had proper 
initial conditions (i.e. we were pointing in some random direction) this would not have worked 
since we may never have crossed the plane.  We first had to get close to Jupiter with our initial 
state, and only then were we close enough to to use B-plane targeting. 

 

 

The b-plane is defined to be the plane that contains the focus of an idealized two-body 
trajectory (assumed to be a hyperbola) that is perpendicular to the incoming asymptote of that 
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hyperbola. The incoming and outgoing asymptotes,  and , and the focus are contained in 
the trajectory plane, which is perpendicular to the b-plane. The intersection of the b-plane and 
the trajectory plane defines a line in space. The b-vector is defined to lie along this line, 
starting on the focus and ending at the spot where the incoming asymptote pierces the b-

plane. The vectors and lie in the b-plane and are used as axes. 

Our initial state from Trajopt gives us the right direction for our transfer trajectory to get close 
to our Bplane targets, but since it was created using 2-body approximations, and since we are 
using full integration, we will need to tweak things in order to hit our desired Bplane targets 
that take us to Pluto.   

Let’s set up our targeting profile to achieve our Bplane goals. 

 

7. Add three results to the ‘Prop to Jupiter’ segment. 

a. From the ‘MultiBody’ Calc Object folder, BdotT.  Reconfigure this result to be Jupiter 
centered. 

b. From the ‘MultiBody’ Calc Object folder, BdotR.  Reconfigure this result to be Jupiter 
centered. 

c. Add the Epoch object. 

8. In the targeter panel, rename the targeting profile ‘Jupiter Bplane’. 

9. Select the Properties button for the Jupiter Bplane profile, and activate these Controls and 
Constraints 

a. Activate these Controls from the Initial State segment: 

i. AsymDec.  Perturbation of 0.1 deg, Max Step Size of  1 deg. 

ii. AsymRA.  Perturbation of 0.1 deg, Max Step Size of  1 deg. 

iii. C3.  Perturbation of 0.001 km^2/sec^2, Max Step Size of  0.1 
km^2/sec^2. 

b. Activate the Constraints 

i. BdotT.  Value of 355,888 km.  Tolerance of 10 km. 

ii. BdotR. Value of 2,604,256 km.  Tolerance of 10 km. 

iii. Epoch.  27 Feb 2007 12:00:00.00 , tolerance of 1 hr. 
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10. Set the Mode for the ‘Bplane’ profile to ‘Iterate’. 

11. Set the Targeter Action to Run Active Profiles Once. 

12. Insert a return segment   after the ‘Prop to Jupiter’ segment. 

13. Run the targeter. 

14. From the properties of the segment, change the coordinate system for the ‘Prop to Jupiter’ 
segment to ‘Jupiter Centered CBI’.  

15. Check the results window and see that our initial B-Plane parameters are reasonable. 

16. Set the Targeter Action to Run Active Profiles. 

17. Run the targeter again. 

18. Bring up the Summary Report on the ‘Prop to Jupiter’ segment, and inspect both the ‘Stopped 
On’ condition (which identifies which stopping condition ended the segment) and the altitude 
(above Jupiter) at the time.   

 

Target Pluto Approach Conditions 

Now that we have hit our desired conditions at Jupiter, we need to try and hit Pluto.  Our Bplane 
parameters will get us close to Pluto, but not as close as we’d like since they too originally came 
from 2-Body approximations.  

 

19. Add two results to the ‘Prop to Pluto’ segment. 

a. From the ‘MultiBody’ Calc Object folder, BdotT.  Reconfigure this result to be Pluto 
centered. 

b. From the ‘MultiBody’ Calc Object folder, BdotR.  Reconfigure this result to be Pluto 
centered. 

c. Add the Epoch object. 

20. Create another profile, called ‘Pluto Bplane’ 

a. Activate these Controls from the Initial State segment: 

i. AsymDec.  Perturbation of 0.001 deg, Max Step Size of  0.01 deg. 
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ii. AsymRA.  Perturbation of 0.001 deg, Max Step Size of 0.01 deg. 

iii. C3.  Perturbation of 0.001 km^2/sec^2, Max Step Size of  0.05 
km^2/sec^2. 

b. Activate the Constraints from the ‘Prop to Pluto’ segment: 

i. BdotT.  Value of 10,000 km.  Tolerance of 10 km. 

ii. BdotR. Value of 0 km.  Tolerance of 10 km. 

iii. Epoch.  30 Jun 2015 00:00:00.00 , tolerance of 1 hr. 

21. Apply the corrections from the previous ‘Jupiter Bplane’ profile. 

22. Set the Mode for the ‘Jupiter Bplane’ profile to ‘Not Active’. 

23. Set the Mode for the ‘Pluto Bplane’ profile to ‘Iterate’. 

24. Select the Return segment after the ‘Prop to Jupiter’ segment and activate the  ‘Allow Targeter 
Bypass’ option. 

 

25. Set the targeter action to ‘Run Active Profiles Once’. 

26. Run the targeter. 

27. Note the difference between the desired and achieved parameters at Pluto. 

 

MCS Segments that appear after a Return segment within a targeter do not appear in the final 
ephemeris of the satellite.  Although the segments execute and are used for calculation and targeting 
purposes, once the targeter has finished they do not actually execute and get included within the 
final ephemeris.  Thus, although you will see these segments propagate graphically during targeting, 
once targeting finishes they will not be drawn. 

 

Note 
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28. Change the default coordinate system for the ‘Prop to Pluto’ segment to be ‘Pluto Centered 
Inertial’. 

29. Bring up the Summary Report on the ‘Prop to Pluto’ segment, and inspect the ‘Stopped On’ 
condition (which identifies which stopping condition ended the segment) the altitude (above 
Pluto). 

30. Turn off the MCS Option ‘Draw Trajectory as it is Calculated’. 

 

The use of JPL Spice files while drawing the 2D graphics for a mission of this length greatly increases 
the time of the propagation.  Thus, for speed, we will turn off the graphics during targeting. 

 

Note 

 

31. Set the Targeter action to ‘Run Active Profiles’. 

32. Copy the ‘Prop to Pluto’ Segment and paste it outside and after the targeting sequence.  
Rename it ‘Prop to Pluto Final’. 

33. Create another propagation segment after the external ‘Prop to Pluto Final’ 

a. Rename the segment ‘Prop Through Flyby’. 

b. Give the segment a stopping condition of ‘Duration’ and change the Trip value to be 5 
days. 

c. Change the propagator to ‘Heliocentric’. 

34. Run the targeter. 

35. Change your animation time to be that of your closest approach. 

36. Experiment with the Constraint values, changing the desired BdotT to 5000 or less. 

37. Experiment with the BdotT and BdotR results on the ‘Target to Pluto’ segment.  Note that the 
reference pole vector for B-plane targets has multiple options.  Select a different option and 
see where the resultant trajectory places us with respect to Pluto. 
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